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GETTING STARTED

Class Overview

This is a class for beginning computer users. You should be familiar with the Microsoft Windows operating system and using a browser to surf the Internet.

We will be going over the basics of using the Internet to find employment resources. We’ll learn how to safely search for jobs, create a professional online presence, and keep track of applications. If you do not feel comfortable with any of the activities, it is totally fine not to participate.
Please let the instructor know if you have questions or concerns before the class, or as we go along.

You Will Learn How To: 

	Find employment resources online
	Help employers find you
	Register for employment sites

	Post your resume online
	Create a professional online presence
	Apply through employers’ websites

	Keep track of job search materials
	Find more help!
	


HOW THE INTERNET CAN HELP

The Internet can be an important tool in finding and applying for a job.  As you are probably aware, it is often difficult, if not impossible, to apply for many jobs today without access to a computer, the Internet, and an e-mail address.  In addition, when filling out electronic applications (or even filing for unemployment checks), it is necessary to be able to navigate and fill out online forms.  While this can be frustrating and sometimes intimidating, the Internet also provides great opportunities for you to expand your job search, and to engage in both active and passive job seeking strategies.
Seven Job-Searching Functions of the ’Net

1.    Getting advice on job searching, writing resumes and cover letters, interviewing, and more (e.g., go to www.google.com and search for “sample cover letters”).
2.    Researching a career by searching for career-specific websites using a search engine (e.g., search for “careers in banking”).

3.    Searching for a job using a national job bank (e.g., careerbuilder.com, indeed.com).

4.    Searching for a job using a local job bank (e.g., TriangleHelpWanted.com).  
5.    Searching for a job using a career-specific job bank: Find these using search engines (e.g., search for “teacher job bank”). 
6.    Subscribing to e-mail listservs for specific careers: Find these through the websites of professional communities and associations.  (e.g., The American Institute of CPAs (AICPA)). 
7.    Researching a company: Find the website of a potential employer using a search engine and then find out more information about jobs, the company, and more by looking around their site.
Letting Employers Find You

When conducting a job search, you can make it easy for employers to find you online. Employers, who can be inundated with resumes when they post jobs, sometimes seek candidates before they post a job. They often look for qualified candidates who aren’t necessarily looking for work, but who may be interested if the right job comes along. Anyone who doesn’t want to pass up on a potentially excellent opportunity should make their professional credentials readily accessible online.

Companies continuously search for candidates on websites like Monster.com or LinkedIn.com, mining the Internet to find the best people to hire, regardless of whether the candidate has expressed interest in their company or not. Companies also use technology that will find applicants for them, using focused keyword searching by location, education, prior employer, job title, and skills.  This is why it is very important to list all of your job experiences on your online resume—if a company is looking for someone with “project manager” experience and you don’t list it on your resume, they’ll never find you!
Tools used by employers conducting candidate searches include AIRS Sourcepoint and Monster.com’s SmartFind.  You don’t need to worry about how to use these programs; you’ll just need to understand how you can make your resume searchable and findable to employers.  We’ll talk about how to do this in the following section.
Keep in mind that, although creating online profiles and passively searching for work is a great strategy, it probably won’t be enough to get you a job—with so many people looking for work, employers are waiting for you to approach them.  But don’t worry!  We’ll cover how to do that later in this class too.
CREATING A RESUME

Style and Content
Find a style that suits your industry. Research different styles of resumes using the Internet (for example, you can Google search for “sample resume”).

· Chronological: Most common; starts with most recent jobs and work backwards (usually only 10 years into the past) (See page 9 for an example)
· Functional: Focused on skills rather than the employer or time frame (See page 10 for an example)
· Combination: Resume with both chronological and functional elements 

Decide on sections to include: 
· Contact Information 

· Objective (optional)

· Education 

· Experience, Training, Military History, Responsibilities, Dates 

· Relevant Skills (computer, languages, etc.), Accreditation, Licenses 

· Activities and Interests 

· List of references (or include "References upon request" statement) 

DON’T include 
· Salary information 

· Jargon 

· Mention of family, marital status, religion, race, health problems 

· Graphics 

· Weaknesses 

And a few more tips:

· Make your resume appealing, but don’t exaggerate. Let your experience do the talking. 

· Use strong verbs to start your sentences, and describe your responsibilities in as much detail as possible. What did you do? For how long? What were you responsible for? 

· Maintain a consistent style throughout. Use the same style of bullets across the different sections. While each section contains different types of information, it is important that they look similar. Use the same font type and size for each of your headings. (The next section will explain how to do some formatting.) 

· Edit carefully and be sure and have at least one person with an eye for detail review it for you. If possible, two or more editors should verify that there are no typos or grammatical errors. 

· When describing your current job, the verbs should be in present tense. For any jobs in the past, the verbs should be in past tense.

Resumes for the Web
Computers are being used in most large companies to scan resumes.   

Tips to help it scan well:

· Send a clean, printed copy – not a photocopy

· Use common fonts – avoid excessive italics, underlining 

· Leave out horizontal lines. Some scanners see that as a page break and assume it is the end of the page. 

· Font should to be between 10 and 14 points (12 is standard)

· Leave out decorations/graphics 

· Keep formatting simple 

· Paper should not be stapled or folded 

· Use keywords included in job description

· If possible, use a PDF version so that the formatting will not differ

· Have a plain text version of your resume available in case you have to copy and paste your information into text boxes.

Verb List for Resumes and Letters

*Note that all verbs are in past tense
Management Skills

administered

analyzed

assigned

attained

chaired

consolidated

contracted

coordinated

delegated

developed

directed

evaluated

executed

improved

increased

organized

oversaw

planned

prioritized

produced

recommended

reviewed

scheduled

strengthened

supervised

Communication Skills
addressed

arbitrated

arranged

authored

collaborated

convinced

corresponded

developed

directed

drafted

edited

enlisted

formulated

influenced

interpreted

lectured

mediated

moderated

negotiated

persuaded

promoted

publicized

reconciled

recruited

spoke

translated

wrote

Research Skills
clarified

collected

critiqued

diagnosed

evaluated

examined

extracted

identified

inspected

interpreted

interviewed

investigated

organized

reviewed

summarized

surveyed

systematized

Technical Skills
assembled

built

calculated

computed

designed

devised

engineered

fabricated

maintained

operated

overhauled

programmed

remodeled

repaired

solved

upgraded

Teaching Skills
adapted

advised

clarified

coached

communicated

coordinated

demystified

developed

enabled

encouraged

evaluated

explained

facilitated

guided

informed

instructed

persuaded

set goals

stimulated

trained

Financial Skills
administered

allocated

analyzed

appraised

audited

balanced

budgeted

calculated

computed

developed

forecasted

managed

marketed

planned

projected

researched

Creative Skills
acted

conceptualized

created

customized

designed

developed

directed

established

fashioned

founded

illustrated

initiated

instituted

integrated

introduced

invented

originated

performed

planned

revitalized

shaped

Helping Skills
assessed

assisted

clarified

coached

counseled

demonstrated

diagnosed

educated

expedited

facilitated

familiarized

guided

motivated

referred

rehabilitated

represented

Clerical or Detail Skills
approved

arranged

catalogued

classified

collected

compiled

dispatched

executed

generated

implemented

inspected

monitored

operated

organized

prepared

processed

purchased

recorded

retrieved

screened

specified

systematized

tabulated

validated

More Verbs for Accomplishments
achieved

expanded

improved

pioneered

reduced (losses)

resolved (problems)

restored

spearheaded

transformed

Formatting Your Resume

Many word processing programs will have templates available for you to use. In Microsoft Word, go to the Microsoft Office Button or the File menu at the top left of the screen. Select New and you will see a list of available templates. You can either look for the category of “Resumes and CV” or search for “resume” in the search box. This will provide a template resume that allows you to fill in your personal information. You can also type your resume in a blank document and use some of the following options to format it.
Font: 

1. Highlight the text you want to change. To do this, left click at one end of the text. While holding down the left mouse button, drag the mouse over the text and let go when you get to the end of the text you wish to change. It should appear highlighted. 

2. Then make sure you have the Home Tab selected at the top. 

3. You should see the formatting options shown in the image below: 

· From this tab, you can define the Font type you want. Times New Roman is a common font. 

· Under the Font section, you can also choose the font style Bold, Italic, or Bold Italic. 

· Underline style lets you underline your text. 

· This Is What Small Caps Looks Like
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Font Style | Font Size | Font Color | Text Alignment

*Remember that simple, easy-to-read fonts appear the most professional. Times New Roman and Garamond are two popular fonts to use for professional purposes. 

Bulleting: 

· [image: image11.png]


Bullet points are a good way to list accomplishments clearly. 

· If you want to insert a bulleted list, simply click one of these two buttons on the Home Tab in the Paragraph section.
Other Formatting Options:

· Use the tab key, the space bar, and the indent markers in the ruler to align items properly.
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Highlight a section of text, go to the Paragraph section on the Home Tab and click on the arrow in the corner to access all the options to control alignment and other formatting.
Cover Letters

Resumes almost always come with a short cover letter. Cover letters are used to introduce your resume to the reader. Most readers will not know who you are or why you are sending them a resume if you do not introduce yourself. Cover letters are also used to highlight the most important aspects of your resume that are relevant for that particular job. Although scanners are being used to sort resumes, a human will eventually look at your entire application to determine if you get an interview, so spend some time writing your cover letter.
Letters should:

· be formal (Dear Ms. Smith, Sincerely, etc.)
· be direct and to the point 

· express interest in the position and company 
WILL B. HIRED (Chronological Example)
123 Pleasant Street

Hillsborough, NC 27278
919.123.4567

will.b.hired@email.provider.com
WORK EXPERIENCE 

Canefield Technical Services, Greensboro, NC 




Administrative Assistant 





    

 Oct 2012 – Present 

· Oversee daily operations and manage a team of six office personnel 

· Collaborate on creation of a large grant application 

· Manage new and existing customer records using MS Access 
Barnes & Noble, Durham, NC 




 

Customer Service Representative 





Jan 2011 – Oct 2012
· Responded to customer queries and assisted with information needs 

· Received superior customer service award 

EDUCATION  [This section can come first if you have recently graduated or if education is the main requirement of the job]
University of North Carolina at Chapel Hill, Chapel Hill, NC 
  B.A. English





     


May 2010

Durham Technical Community College, Durham, NC 

  Completed 36 general education credits 


       

August 2007 – May 2008
TECHNICAL SKILLS 

· Proficient in MS Office 2007, HTML, & Adobe Photoshop 

OTHER SKILLS 

· Conversational Spanish skills 

· Superior organization and time-management skills 

COMMUNITY INVOLVEMENT 

· Volunteer English tutor at Community Center 

· Volunteer monthly at local Boys & Girls Club events 

REFERENCES 

Available upon request [Use this line if you wish to list a current employer and want to be forewarned before this person is contacted. Otherwise, simply list your references and their contact info]

WILL B. HIRED (Functional Example)
123 Pleasant Street

Hillsborough, NC 27278

919.123.4567

will.b.hired@email.provider.com
PROFESSIONAL PROFILE [A brief overview of who you are and your skills.]
Administrative assistant proficient at overseeing daily operations with experience managing personnel teams and working directly with customers. Has conversational Spanish skills.
PROFESSIONAL ACCOMPLISHMENTS

Customer Service & Skills
· Received superior customer service award
· Responded to customer queries and assisted with information needs
· Proficient in MS Office 2007, HTML and Adobe Photoshop
Leadership & Management
· Managed a team of six office personnel

· Developed superior organization and time-management skills

Collaboration & Engagement
· Participated in the creation of a large grant application
· Volunteer English tutor at Community Center

· Monthly volunteer at local Boys & Girls Club

WORK EXPERIENCE 

	Canefield Technical Services
	Greensboro, NC
	                Oct 2012 – present

	  Administrative Assistant
	
	

	
	
	

	Barnes & Noble
	Durham, NC
	            Jan 2011 – Oct 2012

	  Customer Service Representative
	
	


EDUCATION  [This section can come first if you have recently graduated or if education is the main requirement of the job]

	University of North Carolina at Chapel Hill, Chapel Hill, NC
	May 2010

	  B.A. English
	

	
	

	Durham Technical Community College, Durham, NC
	August 2007 – May 2008

	  Completed 36 general education credits
	


REFERENCES 

Available upon request [Use this line if you wish to list a current employer and want to be forewarned before this person is contacted. Otherwise, simply list your references and their contact info]
GETTING READY TO HUNT
Making Your Information Accessible Online

When you want employers to find you, it's important that your resume and the profiles you post have specific information. This will allow employers to search for you by your credentials and qualifications.

Your online resume should contain: 

· Keywords: If you're not sure what to include, use a job search engine like Indeed.com to search for jobs that match your qualifications. Once you come up with some terms that fit, use them in your resume. That way, you will be found by employers seeking candidates with similar qualifications. Be sure to include keywords from the job description; employers will be looking for these specifically. Examples might include names of computer programs you know how to use, technical skills, and words specifically related to a field (e.g., “occupational therapy,” “point-of-service”).

· Job Titles: Employers are often interested in candidates with specific experience and will search for people with that title in their resume (e.g., Online Marketing Coordinator or Telephone Sales Manager). 

· Qualifications/Certifications: Be specific; if you have Microsoft Certification or Red Cross certification, be sure to include that.
· Affiliations: If you belong to any relevant professional organizations, be sure to list them. 

Update your resume regularly. Many resume databases have options for employers to search only the newest resumes or those posted with a certain period of time. Keeping your resume up-to-date will help employers find you.
Keeping Personal Information Private

Making your professional information available online is different from having personal information in your Facebook, Twitter, or other social networking accounts. These are not appropriate places to post your resume. Professional and personal lives should be kept separate—you wouldn’t want a hiring manager or recruiter to read your private profile or to see compromising photographs. Creating a professional profile on a professional site is the best way to make yourself visible while keeping your private life separate. These professional sites allow you to post your resume and any other information you may feel is necessary. The most famous example of this type of site is LinkedIn.com. You can also limit the contact information viewable on your resume if you have privacy concerns.

It is important to differentiate between legitimate job postings and advertisements designed to trick you into giving personal information, paying money to get a job or small business, or other scams. Some common ways to identify these advertisements are if they ask you to provide any kind of payment information, confidential information like your social security number, or anything else you might be uncomfortable providing. Remember: If it sounds too good to be true (“Make Big $$$ Working 4 Hours from Home”), it probably is.
Maintaining a Professional Online Presence
Just like when you go in for a job interview and you make sure to wear nice clothes, your online presence needs to be professional and presentable. Here are a few hints to keep your web persona looking its best:

· Make sure to proofread. It’s easy enough to catch typos and grammatical errors (especially if you use a word processor with spell-check or have a friend read over your application materials), and the extra few moments you spend can make the difference between having your resume taken seriously or not.
· Compose your e-mails and instant messages appropriately. Consider everything you send online that is related to a job as official business correspondence, just like you were writing a letter or making a phone call. Use formal language and write in complete sentences.
· Communicate professionally with your contacts. Whether you contact them or they contact you, make sure you write courteously, use professional language, and double-check the spelling of the name of the person and company correctly.
· Keep track of where you have posted your resume and applied to jobs. Especially if you are applying to many different jobs, it can be easy to lose track of all the places you’ve applied and sent your resume. By keeping track, it will be easier for you to follow up with your applications and to update your resume at regular intervals.
· Use an e-mail address that sounds professional. While it’s fine to write to friends and family from sexypanda123@gmail.com, it won’t make the best impression on your future employer. Since you can have as many e-mail addresses as you like, you might consider creating one just for professional communication with an address like firstname_lastname@emailprovider.com. You can, of course, use that same e-mail address for all of your communications—it can’t hurt to look professional to your friends too!
· Only post pictures of yourself that you wouldn’t mind your future boss seeing. A good rule of thumb is: If you post it on the Internet, someone else can find it. Definitely don’t put compromising pictures of yourself on websites without privacy settings, and think carefully before posting those party photos on Facebook.
ONLINE TOOLS FOR JOB SEARCHING

Job Search Engines

There are many different job search engines out there, but not all of them are equally good. Here is a list of major search engines that allow users to search the major job sites, company sites, associations, and other online job sites by keyword and location. While these sites have the option to create a personalized account, most of them also allow you to use certain functions without an account (for example, conducting a search but not saving your results). 
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Bureau of Labor Statistics (www.bls.gov)

This site is run by the US Department of Labor and provides national employment statistics. It provides data on topics like median salaries, education requirements and projected growth rates of a wide variety of occupations. This site is less useful for finding job listings, but can be a good place to start to get general information on a job, particularly if you want to switch careers or try a new industry. To access this information, click on the “Publications” link at the top of the screen, then click on “Occupational Outlook Handbook.” From there, you can sort the results by groups of occupations to begin your search. Additionally, you can browse an A-Z index of jobs, or you can browse by highest paying, fastest growing, or most new jobs.
Indeed.com 
Indeed.com includes millions of job listings from thousands of web sites, including company career pages, job boards, newspaper c1assifieds, associations, and blogs. Job seekers may also search job trends and salaries, read and participate in discussion forums, research companies, and even find people working for companies of interest through their online forums. 


LinkUp.com 
LinkUp is a job search engine that searches for jobs on company sites. The job postings are from small, mid-sized, and large companies, and are continuously updated with the company websites. 


SimplyHired.com 
SimplyHired searches thousands of job boards, classifieds, and company sites. Advanced search options include type of job, type of company, keyword, location, and the date that the job was posted. It also includes salary information. 
Monster.com 
Monster.com is a national job search engine that assists job seekers in finding employment by matching their skills and locations with potential employers. The site also has resources such as job hunt strategies, resume and cover letter samples, interviewing advice, and career development advice. 
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CareerBuilder.com 
CareerBuilder.com is a national job search engine that serves both employers and job seekers, and helps job seekers to find employment by matching their career area and location. The site allows you to post a resume (for passive job seeking), and also provides advice and career resources.

There are also many career-related social networking sites available. An internet search of “professional networking sites” will bring up many of the leading ones. The most popular one is probably LinkedIn.com, a social networking site devoted to professional development and finding jobs. 

LinkedIn.com

To use LinkedIn, you’ll have to create a free profile with a username and password, then upload your resume. The website pulls out relevant information from your resume to make it easy for employers to search, and you can connect with colleagues and friends to build a professional network. Many employers list jobs on LinkedIn, but acquaintances can also help you find a job by looking at your resume. Additionally, co-workers and supervisors are able to write recommendations on your profile that potential employers can see.
Other Places to Look
College Alumni Associations 
College graduates should always check with their alma mater to see what networking resources are available. Many colleges have alumni databases specifically designed for networking purposes. Alumni are often interested in recruiting candidates from their school, so take advantage of whatever resources are available. 
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Employer Alumni Associations 
In order to stay connected with past co-workers, some former employees have created employer alumni associations. If your prior employers have associations, join them. Former colleagues may be able to help you with your future career plans. 

Professional Associations 
Do you belong to any professional associations? If so, see if they have a member database, and make sure you’re listed in it. It’s just one more good way to help potential employers find you.
NAVIGATING COMPANY WEBSITES

If you already know that there is a company that you are interested in working for, sometimes it makes the most sense to go ahead and look for jobs through the company’s website.  Finding job listings can sometimes be a bit tricky, so let’s practice finding job applications on a company website.
Finding the Application

Sometimes, it can be easy to figure out where to find job listings; there might be a link that says “Employment,” and you should click on that:
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Sometimes, the link will say “Careers”:
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Sometimes it will be in tiny print at the bottom of the page:
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And sometimes it can be very unclear where the job listings are located. Let’s take a moment to look at your favorite businesses and try to find where they keep their employment information.
Once you’ve found the jobs page, you might see a search window like this:
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From here, you can search for specific jobs within the company, using keywords (e.g., “cashier” or “manager”), location, or job number (if you happen to know it).

You’ll then get a list of results matching your search specifications:
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DURHAN-HOMESTEAD 105 WEST NC HIGHWAY 54 DURHAM, NC 27713
NC-Durham

Apply | Addto My Job Cart

022 -5800 - CASHIER®  Parttime

Job Posting War 26, 2010 - Requisition ID 0900436

'DURHANM-VARTIN LUTHER KING 1817 MARTIN L KING JR PKW DURHAM, NC 27707
NC-Durham

Apply | Addto My Job Cart




If a job title looks interesting, click on it to see more information and to apply for the job. Once you’re ready to apply, be sure to have your resume ready to go, saved in a .doc or .pdf format so that you can easily upload it to the application.

Common Application Mistakes

When you are applying to many jobs at once, it can be easy to make a mistake on your application. Most are relatively minor, but it does pay to double-check your application before you send it, since, unlike a paper application, it’s gone once you click “send.”

· When writing a cover letter, make sure you have the correct company written each and every time. Especially if you’re repurposing the same cover letter multiple times, it can be easy to miss one company name from the last application, but that’s a sure game-ender.
· Make sure you follow directions. Each application is a little bit different, but HR looks at applications all day long, so they’ll notice if you don’t answer the question quite the way they want.

· Upload the most recently saved copy of your resume and cover letter—sometimes it even helps to close out of Word before you send the documents, just to have that extra prompt that you have saved the most recent version.

· Name your documents professionally; a good rule of thumb is lastname_company_position_resume.doc

· Check your spelling and grammar!

Sometimes, due to the volume of applications received, you may not hear back about the jobs you have applied for. Some companies may take a few weeks to contact applicants, but you may not hear back at all if you are not selected for an interview. If you have an e-mail address or contact information for a hiring manager or the HR department of a company, you can reach up to ensure they have received your application. If you have not received any communication about a job after a few months, it is safe to assume you are no longer being considered for that position. This will vary depending on the industry and type of job you are applying for. 

FINDING MORE HELP
If you walk out of this class tonight and want to know more about how to find jobs online, great! There are many great resources, both online and in the area, for you to explore. 
The best place to start is your local public library. It has numerous job search and resume resources! Just ask at the information desk.
Resume Writing Help

There are also some resources online that you can access for resume writing help. 
http://www.how-to-write-a-resume.org/ 
http://owl.english.purdue.edu/owl/resource/719/01/

http://careers.unc.edu/sites/careers.unc.edu/files/Resumes_2010.pdf
http://www.nccommerce.com/workforce/job-seekers/job-search-tools

http://jobsearch.about.com/od/resumes/a/resumetoc.htm
http://jobsearch.about.com/od/resumes/a/resumproof.htm
http://www.rileyguide.com/resprep.html

Online Job Searching Help

The Wall Street Journal Careers - http://online.wsj.com/public/page/news-career-jobs.html 

Job Search at About.com - http://jobsearch.about.com/ 

The Riley Guide (run by librarians!) - http://www.rileyguide.com/ 

Orange County Joblink Career Center:

The JobLink Center is a great service that offers help in writing resumes, practicing for job interviews, and suggesting places and people to look for jobs. And if they don’t have quite the service you’re looking for, they can refer you to another local agency that can help you out. So if you’re actively seeking a new job, this is a fabulous (and FREE) resource to take advantage of. http://www.regionalpartnershipwdb.org/orange/

Looking for government jobs? Try one of these sites:
Federal Government’s Official Job Site - https://www.usajobs.gov/

NC Office of State Human Resources - http://www.oshr.nc.gov/jobs/

Orange County Job List: http://agency.governmentjobs.com/orangecountync/default.cfm
Chatham County Jobs: http://www.chathamnc.org/Index.aspx?page=44
Durham County Jobs: http://dconc.gov/index.aspx?page=245&redirect=1
Town of Chapel Hill Jobs - http://www.ci.chapel-hill.nc.us/index.aspx?page=218 

Looking for local jobs?  Try one of these sites:

Durham County Library Reference Pages: Jobs and Careers - http://durhamcountylibrary.org/research/onlineresources/jobs/
Triangle Help Wanted - http://regionalhelpwanted.com/home/79.htm

Triangle Jobs - http://www.trianglejobs.com/


Favorite Job Hunting Websites
	Website/Company Name
	URL
	Login
	Password
	Comments

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	

	
	
	
	
	


Job Application Log
	Date Applied
	Company
	Position Title
	Contact Info
	Status
	Interview Dates
	Notes

	
	
	
	Name: 

Title: 

Email: 

Phone: 


	__ Applied 

__ Phone Intvw 

__ Live Intvw 

__ Job Offer 

__ Closed 
	Phone Interview: 

Live Interview: 
	

	
	
	
	Name:

Title: 

Email: 

Phone: 


	__ Applied 

__ Phone Intvw 

__ Live Intvw 

__ Job Offer 

__ Closed
	Phone Interview: 

Live Interview:
	

	
	
	
	Name: 

Title: 

Email: 

Phone: 


	__ Applied 

__ Phone Intvw 

__ Live Intvw 

__ Job Offer 

__ Closed
	Phone Interview: 

Live Interview:
	






































NOTE: Images and screen captures may differ from those seen on another system.
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